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From the Editors
Welcome to this sample issue of
the AppleWorks Journal, the pop-
ular AppleWorks newsletter from the
AppleWorks Users Group (AWUG). We
created this issue because we want you to
know about AWUG, an independent associa-
tion of more than 15,000 AppleWorks users in
the United States and 51 other countries. AWUG
has one goal – to enhance your productivity with
AppleWorks.

AWUG members receive these valuable services:

• Home or office delivery of a full year (ten
issues) of the AppleWorks Journal. Each 24-
page issue is filled with hints, tips, news and
ideas that will answer your AppleWorks ques-
tions and enhance your productivity with
AppleWorks.

• Unlimited telephone and email technical sup-
port from AWUG’s 53 volunteer-consultants.

• Access to AWUG’s AppleWorks support site
on the World Wide Web. This service helps
you get answers to your AppleWorks questions
24 hours a day.

• Access to AWUG’s Public Domain Library
with more than 500 CDs filled with Apple-
Works templates, graphics and utility programs.

• Significant discounts on AppleWorks-compati-
ble products and other special offers that we
negotiate for our members.

We encourage you to explore AWUG’s website
and learn about AWUG’s services. Then give
AWUG a try – it’s risk free. We’re so sure you’ll
like AWUG’s offerings that we maintain a “satis-
faction guaranteed or all you money back” policy
for our members. ■

Greetings

from AW
UG!
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Jumping to a Page
Dear AWUG,

Is there any quick way to jump to a particular page
in a word processor document?

Mary Bond
via the AppleWorks list-serv

[Kevin Warrene replies: AppleWorks has a “hid-
den” Go to Page command that lets you jump to
any page in a document.

To jump to a page, double-click on the page num-
ber next to the Tools Icon at the bottom of your
document. AppleWorks will display the dialog in
Figure 2 that lets you jump to any page in the doc-
ument.]
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More Powerful Searching

Dear AWUG,

I need help finding records in the AppleWorks data-
base that I use to store my grandmother’s recipes.
It’s a simple database with three fields: Recipe
Name, Ingredients and Instructions (see Figure 1).
Now I want to search for specific combinations of
ingredients in my recipes. For example, I want to
find all recipes that include “chicken” and“onion”
and“sour cream”.

I know how to find all the records that contain
“chicken”. But every time I search for “onion”,
AppleWorks ignores my earlier “chicken” search
and gives me every recipe that contains “onion”,
even if it doesn’t contain “chicken”.

How can I search for these combinations in Apple-
Works?

Mike Greene; Alexandria, Virginia

[Ed: AppleWorks gives you at least three ways to
perform this search. I suggest that you use the
“Find fr om visible” option in AppleWorks’ Find
Record command to search for the appropriate
recipes. Follow these steps:

1. With your database on the screen, select
“Find” fr om the Layout Menu to display the
Find Records screen. Click in the Ingredients
field and type the word “chicken”. Then click
on the “Find” button to find all the records that
contain “chicken”.

2. Once again, select “Find” from the Layout
Menu. Click in the Ingredients field and type
“onion”. Then click on the “Find from Visible”
button before clicking on “Find” (see Figure 1).
That tells AppleWorks to limit your search to the
records you selected earlier. (Those are the
records that contain the word “chicken”.)
AppleWorks will now display the records that
contain “chicken” and “onion”.

3. Repeat step #2 and enter “sour cream”. Apple-
Works will now display only the records that
contain “chicken”, “onion”, and “sour cream”.

When you’re done, select “Show All Records”
from the Organize Menu.]

Letters to AWUG
Windo ws

Figure 2: Go to Page Dialog

Double-click
here…

…to display this dialog.

Figure 1: Selecting “Find from Visible”

Click here to
limit your

search.



Special Sample Issue Page 3
AppleWorks Journal

Letters to AWUG

Changing Regular Quotes to Curly Quotes

Dear AWUG,

I often cut and paste email messages into my
AppleWorks word processor documents. Everything
goes smoothly with one exception – I get straight
quotes and apostrophes instead of curly quotes.

Is there any way to turn the regular quotation
marks into curly quotes after I paste the text into
AppleWorks?

Emily Jackson; via the AppleWorks list-serv

[Ed: You can use AppleWorks’ Find/Change com-
mand to replace the straight quotation marks and
apostrophes with curly quotes. Follow these steps:

1. Select “Preferences” from the AppleWorks or
Edit Menu and “General” from the Preferences
Sub-Menu.

2. If necessary, choose “Text” from the pull-down
Topic Menu. Then de-select Smart Quotes and
click on “OK”.

3. Select “Find/Change” from the Edit Menu and
change all occurrences of <space>" with
<space>“. (Macintosh users: Press Option-[ to
type the “ character.) (Windows users: Hold
down the Alt Key and type 0147 on the numeric
keypad. Then release the Alt Key. Some Win-
dows fonts do not contain curly quotes – those
fonts will type straight quotes.)

4. Click on “Change All” and then on “OK” in
the Find/Change window.

5. Close the Find/Change window. (A bug in
AppleWorks 6 forces you to close this window if
you want to perform multiple Find/Change
operations.)

6. Use the Find/Change Command three more
times as follows:

A. Replace " with ”. (Macintosh users: Press
Shift-Option-[ to type the ” character.) (Win-
dows users: Type Alt-0148.)

B. Replace <space>' with <space>‘. (Macin-
tosh users: Press Option-] to type the ‘ char-
acter.) (Windows users: Type Alt-0145.)

C. Replace ' with ’. (Macintosh users: Press
Shift-Option-] to type the ’ character.) (Win-
dows users: Type Alt-0146.)]

How to Restore the Clippings Tabs

Dear AWUG,

The tabs are missing from the bottom of my Apple-
Works 6 Clippings Window. I need these tabs to
switch between the different clippings collections.
Do you know how to restore them?

John van Gaesbeeck; Brielle, Netherlands

[Hans Anders replies: You can use AppleWorks’
contextual menu to hide and restore the clippings
tabs.

To restore the tabs, hold down the Control Key and
click anywhere in the Clippings Window. (Windows
users: Right-click in the Clippings Window to dis-
play the contextual menu.) Then select “Show
Tabs” from the contextual menu (see Figure 3).
AppleWorks will then display the tabs at the bottom
of the Clippings window.] ■

Figure 3: Restoring the Clippings Tabs
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You can spend hundreds of dollars on programs
that let you create splendid newsletters on a
Macintosh or Windows computer. If you pro-

duce newsletters regularly, insist on perfection and
have the money in your budget, you should proba-
bly get a program such as QuarkXPress or Adobe
InDesign. Then plan on spending hundreds more
for graphics applications you will need to create
the illustrations in your publications.

But this article is for the rest of us – AppleWorks
users who produce an occasional newsletter.

This article will take you step-by-step through the
process of creating a newsletter with AppleWorks.
Along the way, you will produce the two-page news-
letter in Figure 1. As you can see from the figure,
your newsletter will include many of the items that
appear in most publications – articles, graphics, a
banner headline, footers and more. When you are
done, you can use the newsletter you create in this
exercise as a template for your own publications.

Assumptions

Throughout this article I will assume that you
know the basics of AppleWorks. I will also assume
that you know how to create a document, choose a
font, font size and style, center and justify text, and
use the tools on AppleWorks’ Tools Palette.

To keep everyone working on the same articles, I
suggest that you use the three sample files I pre-
pared for AWUG’s Journal Templates.10 disk,
which you can download from AWUG’s website at
<www.awug.org> or order on AWUG’s December
2001 CD for $14.95 plus $2 U.S. s/h. If you don’t
have those files, you can use any AppleWorks word
processor files to complete this exercise.

The procedures you will learn work with all ver-
sions of AppleWorks. However, AppleWorks 5

How to Create Newsletters with AppleWorks
by Jon Saalberg

Jon Saalberg is the AppleWorks Users Group Public
Domain Librarian and Graphics Specialist. Figure 1: Completed Newsletter

AppleWorks Projects
Windo ws
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includes a useful newsletter assistant that auto-
mates much of the newsletter creation process. If
you have AppleWorks 5, I suggest that you explore
that Assistant – it makes it easier to create
newsletters with that version of AppleWorks. [Ed:
For step-by-step directions that describe how to
use AppleWorks 5’s Newsletter Assistant, see “How
to Use AppleWorks’ Newsletter Assistant”, “How
to Improve Your Newsletter Template”, and “How
to Assemble a Newsletter” in the April, May and
June/July 1995 issues of the AppleWorks Journal.
These articles (and all the other articles mentioned
here) are also on AWUG’s AppleWorks Journal
Compendium CDs and are available from AWUG’s
Fax and Copy Service.]

Creating the Document

You will start by creating a drawing document and
setting the parameters for the document. (Al-
though you can create newsletters in word proces-
sor documents, AppleWorks drawing documents
offer a more flexible environment for your news-
letter.) Follow these steps:

1. Launch AppleWorks and create a new drawing
document.

2. Select “Document” from the Format Menu and
set all the margins to .56 inches. (That lets you
print the newsletter on almost any printer. If
your printer accommodates smaller margins, set
your AppleWorks margin settings to those
smaller values.) Do not click on “OK”.

3. Enter the number of pages in your newsletter in
the “Pages Down” area. (In this example, enter
“2” for “Pages Down”.) Your screen should look
like Figure 2. Then click on “OK”.

4. Select “Page View” from the Window Menu so
your monitor displays the breaks between the
pages.

5. Select “Turn Autogrid Off” from the Options
Menu. That lets you place objects anywhere on
the page.

6. Select “Preferences” from the Edit Menu and
“General” from the Preferences Sub-menu.
Confirm that the rectangle with eight handles

is selected in the Object Selection area. Do not
click on “OK”.

7. Select “Text” from the pull-down Topic Menu
and turn on “Fractional Character Widths”.
That ensures better font management in your
printed newsletter. Then click on “OK”.

8. Select “Frame Links” from the Options Menu.
That tells AppleWorks to create linked text
frames whenever you create a text frame in your
document. [Ed: To learn about linked text
frames, see “Everything You Should Know
about Linked Text Frames” in the October 1998
AppleWorks Journal.]

9. Select “Rulers” from the Format Menu and
“Show Rulers” from the Rulers Sub-menu.

Create a Masthead

Now you will create a masthead for your news-
letter. Continue as follows:

10.Select the Text Tool. Then click at the upper-
left corner of the page and drag to create a text
frame that is two inches tall and the full width
of the page.

11.Select a font that will make an attractive head-
line. For this exercise, choose Stone Sans
ITCTT, bold. Set the font size to 60 points.
Then type “School Days”. Press -\ to center
the title. (That’s a backslash. It is above the
Return Key on most keyboards.)

Figure 2: Document Settings

AppleWorks Projects



Page 6 Special Sample Issue
AppleWorks Journal

floating objects, see the sidebar “Using Your
Clippings: In-Line or Free-Floating” on page
14 of the May 2001 AppleWorks Journal.]

15.Choose “Show Clippings” from the File Menu
to display the Clippings window. Then scroll
to the School tab at the bottom of the win-
dow and click on the tab. 

16.Click on the Books graphic and drag the
graphic to the left of the text in your masthead.

17.The graphic is too large for the masthead.
Select “Scale by Percent” from the Arrange
Menu, set both values to 75% and click on
“OK”. Then move the graphic so it is cen-
tered to the left of the text in the title. Your
screen should look like Figure 3.

18.Close the Clippings window.

19.As you can see, the text is too close to the
graphic. With the Arrow Tool still selected,
click once on the text. Then click on the lower-
left handle of the text frame, hold down the
Shift Key, and drag the handle one inch to the
right. AppleWorks will re-center the text in your
newly re-sized frame.

Automatic Page Numbering

Now you will add a footer that automatically num-
bers your pages. The footer will also include a hori-
zontal line that will serve as a graphic element at
the bottom of each page. (AppleWorks does not

“capture” graphics as part of a footer. As you will see,
the work-around is to use dashes when you want to
add a horizontal line to a footer.) Continue as fol-
lows:

20.Select “Insert Footer” from the Format Menu.

21.Press the Return Key to insert extra space above
the line that will display the page number. (With-
out this extra space, the body of your document
can get too close to the text in the footer.)

22.Press -[ to left-justify the text.

23.Hold down the Option Key. Then press and
hold down the hyphen key until AppleWorks
draws a 31⁄4 inch long line. (Option-hyphen
types an “en dash” on Macintosh systems. Win-
dows users should press Shift-hyphen.)

12.The title is too wide to let you add a graphic to
the masthead. Click before the word “Days” and
press the Delete Key to delete the blank space
between the two words. Then press the Return
Key to force the title onto two lines.

13.There is too much space between the two lines
of text. Select “Paragraph” from the Format
Menu and change the Line Spacing metric to
“inches”. Then change the setting to .8 inches
and click on “OK”.

Now you will add a graphic to the masthead. Con-
tinue as follows:

14.Select the Arrow Tool. That tells AppleWorks
to import the graphic as a free-floating object
that you can position anywhere in your docu-
ment. [Ed: For more information about free-

Figure 3: After Moving the Graphic

AppleWorks Projects

Figure 4: After Creating the Footer
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24.Type “<space> Page <space>”. Then choose
“Insert Page #” from the Edit Menu and click
on “OK”.

25.Press the Space Bar. Then hold down the
Option Key and press and hold the hyphen key
until AppleWorks fills the rest of the line. (If
AppleWorks starts a second line, press the
Delete Key until you delete the extra line.) Your
footer will look like the example in Figure 4.

26.Scroll to the top of the document.

27.Save your work on the desktop in an Apple-
Works file called “Newsletter.cwk”.

Volume and Date

Now you will add the volume and date banner
below the masthead. You will start by drawing
two horizontal lines (rules) to separate the ban-
ner from the rest of the newsletter. Follow these
steps:

1. Select the Line Tool. Then hold down the
Shift Key, click at the 2-inch mark down the
page and drag to the right to draw a rule all
the way across the page. (Holding down the
Shift Key “constrains” the Line Tool so it
draws a horizontal rule.)

2. Copy and paste the rule. The copy will be on
top of the original rule. Use the Down Arrow
key to move the new rule down 1⁄4 inch.

3. Select the Text Tool. Then click and drag to
create a linked text frame that fits between
the rules. (You may find it easier to draw the
text frame over the rules and re-size it later.)

4. Set the font to Times, italic, 14 point and type
“Special Edition”. Then press the Tab Key and
type “September 15, 2001”.

5. Now you will set a right tab for the line of text.
To do that, select “Rulers” from the Format
Menu and “Ruler Settings” from the Rulers
Sub-menu. Then switch to the text ruler and
click on “OK”. (Please review this step – from
now on I will assume you know how to switch
between the graphic and text rulers.)

6. Select the Right Tab icon and drag the icon to
the right margin on the ruler (see Figure 5).

The date should jump to the right margin when
you release the mouse button.

7. Switch to 200% view and check if the text is
positioned attractively between the rules. If it is
not, select the Arrow Tool and re-size and/or re-
position the text frame until the text is centered
between the rules. Then return to 100% view.

8. Once again, save your work.

Adding the First Article

Now you will add the first article, starting with its
headline. Follow these steps:

Figure 5: Setting the Right Tab

…to here.Drag the Right
Tab icon…

AppleWorks Projects

Figure 6: After Creating Text Frame for Article

New text
frame.
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page. Then click and drag down to the top
of the footer and to the right margin on the
page. (Limiting the frame to the first page
will take some patience – AppleWorks will
want to continue the frame onto the second
page. Just be patient and you will get it.)
When you release the mouse button your
screen should look like Figure 6.

3. With the cursor flashing at the beginning of
the text frame, select “Insert” from the File
Menu and navigate to the “Democracy in
Education.cwk” file on AWUG’s Journal
Templates.10 disk. Insert that file.

Now you will format the headline. Continue as
follows:

4. Triple-click on the first line of the imported
text to highlight the title of the article. Set
the font to Stone Sans ITCTT, bold, 18
point.

5. Press -[ to left justify the title.

6. Select the Line Tool. Then click just below
the title, hold down the Shift Key and drag
to draw a line to the right margin. Your
screen should look like Figure 7.

7. Double-click in front of the word “by” under
the title. Then hold down the Shift Key and
press -Down Arrow to highlight all the
text in the article. Change the font to
Times.

8. Triple-click to select the byline of the arti-
cle. Set the font style to italic.

9. Press -[ to left-justify the byline.

10.Select “Writing Tools” from the Edit Menu
and “Auto-Hyphenate” from the Writing
Tools Sub-menu. Hyphenation is optional,
but many readers find the straighter right
margins more attractive on the page.

As you can see from the overflow “x” at the bot-
tom-right corner of the text frame, the article does
not fit in this frame. Later, you will put the over-
flow on page two, but now you will adjust the
frame and text so the article “breaks” nicely at the
bottom of this page. Continue as follows:

1. Switch to the graphics rulers.

2. Select the Arrow Tool and then the Text Tool.
(That tells AppleWorks you want to draw a new
linkedtext frame. Otherwise, AppleWorks con-
tinues to display the regular text cursor.) Using
the rulers as a guide, put the cursor 31⁄2 inches in
from the left margin and 21⁄2 inches down the 

Figure 7: After Creating the Headline

AppleWorks Projects
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Figure 8: First Column Completed

Missing rule indicates
text flowed onto 
the next line.
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2. Select the Text Tool, click in the upper left
corner of the page, and draw a 1⁄2-inch tall text
frame all the way across the top of the page.

3. Set the font to Stone Sans ITCTT, bold, 24
point. Then type Cheetah (Acinonyx Jubatus).

11.With the Text Tool still selected, click after
the word “sequence” in the last complete
paragraph on the page.

12.Press the Tab Key. Then change the font style
to italic and type (Continued on page 2.).

13.Switch to the text ruler. Select the Right Tab
icon and drag the icon to the right margin on
the ruler (see Figure 5). When you release the
mouse button, the “continued” message
should jump to the right margin. 

14.Select the Arrow Tool. Then click on one of
the handles at the bottom of the column and
drag straight upward until the last line of text
below the “continued” message disappears
from your screen. Your screen should look like
Figure 8.

15.Examine the footer at the bottom of the page.
On some systems, it will run over onto a sec-
ond line as in Figure 8. If this happens to you,
click anywhere on the horizontal line in the
footer and press the Delete Key. Then click
anywhere in the body of the newsletter and
save your work.

Now you will add three graphics to finish the first
page. To do that, switch to the Arrow Tool. Then
repeat steps #15 and #16 on page 6 and add the
music, crayons and globe clippings to the page.
These graphics fit nicely at their default size –
you do not have to re-size the graphics.

Your completed page should look like the exam-
ple in Figure 1. Close the Clippings window and
once again, save your work.

Page Two Layout

Now you will format page two, starting with the
article at the top of the page. As you can see from
Figure 1, the article will contain three columns
and a picture of a cheetah. The headline goes
across all the columns, so you must put it in a sepa-
rate text frame.

Follow these steps to create the headline:

1. Switch to the graphics ruler and scroll to the
top of page two.

Figure 9: After Creating the Second Headline

Figure 10: Calculating Column Widths

Formula This Newsletter

= Width of page = 8.5 inches
– Total width of left and right margins – 1.1 inches
– Total space between the columns – 1.0 inches
= Usable width of the page = 6.4 inches
÷ Number of columns ÷ 3
= Width of each column = 2.1 inches

AppleWorks Projects

Figure 11: After Drawing the Text Frame

Click here to
create a linked
frame.
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6. Select the Text Tool. Then click at the left
margin just below the 10.5-inch mark on the
ruler at the left edge of the page. Drag to cre-
ate a 2-inch wide and 6-inch tall text frame.
(The bottom of the frame should be at the
16.5-inch mark on the rulers at the left edge
of the page.) This frame is larger than you
need, but you will adjust its size later.

7. Select the Arrow Tool and click within the
frame you just drew. AppleWorks will display
the text frame with a down-pointing arrow at
the bottom of the frame (see Figure 11). The
arrow indicates that you can link another frame
to the one you just drew. Click on that arrow.

Now you will draw the second and third linked
columns. Continue as follows:

8. Put the cursor just below the 10.5-inch mark
on the left ruler and at the 2.5-inch mark on
the top ruler. Then click and drag to create a
2-inch wide column that ends at the 16.5-
inch mark on the left ruler.

9. Click on the down-pointing arrow at the bot-
tom of that frame.

10.Put the cursor just below the 10.5-inch mark
on the left ruler and at the 5-inch mark on
the top ruler. Then click and drag to create
another 2-inch wide column that ends at the
16.5-inch mark on the left ruler.

As you can see, the right-most column does not
go to the right margin. Now you will spread the

columns out so the extra space appears between
the columns and not at the right margin. Continue
as follows:

11.With the right-most column still selected, press
the Right Arrow Key until the right edge of the
column is at the right margin.

12.Hold down the Shift Key and click somewhere
in the middle of the now invisible first and sec-
ond columns. That will select all three columns.

13.Choose “Align Objects” from the Arrange
Menu. Then select “Align top edges” from the
Top to Bottom adjustments. Select “Distribute
Space” from the Left to Right adjustments (see

4. Select the Line Tool, hold down the Shift Key
and draw a rule all the way across the page
underneath the text. Your screen should look
like Figure 9.

5. With the rule still selected, hold down the Shift
Key and click on the headline to select both
objects. Then choose “Group” from the
Arrange Menu.

Now you will create the columns for the article.
You can estimate the width of the three columns,
but I use the formula in Figure 10to determine
their width. As you can see from this figure, each
column should be approximately two inches wide.
Continue as follows to create the columns:

Figure 12: Distributing Space Between the Columns

Click here…

…and here.

AppleWorks Projects

Figure 13: After Inserting the Article
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on the text in the first frame. Then hold down
the Shift Key and click on the two other
columns. Your screen should look like Figure
15. Release the Shift Key.

9. Click and hold on the lower-right corner of the
first frame (see Figure 15). Then drag straight

Figure 12) and click on “OK”. AppleWorks
will move the middle column so it is equidis-
tant from the other two columns.

Now you will insert the text. Continue as fol-
lows:

14.Click in the first frame. Then select “Insert”
from the File Menu and insert the “Chee-
tahs.cwk” text into the frame. Your screen
should look like Figure 13.

15.Triple-click on the title at the beginning of
the first column. Then press the Delete Key.

16.Hold down the Shift Key and press -Down
Arrow to select all the text. Change the font
to Times.

17.Change the attribution at the end of the arti-
cle to italics. Once again, save your work.

Inserting a Photo

Now you will insert a photograph of a cheetah
into the article. Follow these steps:

1. Select “Show Clippings” from the File Menu.

2. Select the Arrow Tool. That tells AppleWorks
to insert the graphic as a free-floating object
on top of the article. Click on the Arrow Tool
again to de-select all the selected objects.

3. Click on the Photos tab at the bottom of the
Clippings window. Then click on the cheetah.
jpg graphic and drag it into your newsletter.

4. Close the Clippings window.

5. The photograph is too large for your document.
Select “Scale by Percent” from the Arrange
Menu and enter 65% for both percentages.

6. Select “Text Wrap” from the Options Menu.
Click on “Regular” and then on “OK”. That
“pushes” the text away from the edges of the
photograph.

7. Move the picture into position near the center of
the article. Your screen should look like Figure 14.

Now you will shorten the text frames so the article
fills all three frames. Continue as follows:

8. With the Arrow Tool still selected, click once

Figure 14: After Placing the Photo

AppleWorks Projects

Figure 15: After Selecting the Columns

Click here and 
drag upward.
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draw a horizontal rule across the page slightly
below the 15-inch mark.

2. Select the Rectangle Tool and draw a 31⁄4-inch
wide box that starts at the left margin below
the rule. The box should end at the footer at
the bottom of the page. Your screen should
look like Figure 17.

3. Use the Fill Color palette to set the box’s
color to a light blue. Then set the line width
to “None”.

4. Select the Text Tool. Then click and drag to
create a text frame just inside the colored box.

5. Set the font to Stone Sans ITCTT, bold, 18
point. Then type “School News” and press
the Return Key.

6. Insert the text from the file “School News.cwk”.

Next, you will format the text of the article and
get it to fit on the page. Continue as follows:

7. Click once before the “W” in “Welcome”.
Then hold down the Shift Key and press -
Down Arrow to highlight all the text you just
added. Change the font to Helvetica, 11 point.

upward about 1⁄2-inch to shorten all three frames.
Repeat this process until the text fills all three
columns (see Figure 16).

Next, you will “tweak” the objects into their final
position. Continue as follows:

10.Click on the Arrow Tool to de-select all the
objects.

11.Examine the right-most column. Sometimes the
right edge of this column “creeps” off the right
margin of the document. If the right-most words
on some lines are clipped, click once in the col-
umn and use the Left Arrow Key to move the col-
umn back on the page. (You should see the right-
most frame line.)

12.Click once on the photograph and use the Arrow
Keys to move it into its final position.

13.Save your work.

Adding a Highlighted Item

Now you will add a short article that appears in front
of a colored background. The background adds visual
interest to the second page and leads your reader’s eye
to that article. Follow these steps:

1. Select the Line Tool, hold down the Shift Key and

A Review of What You Learned
The accompanying article taught you how to cre-
ate a newsletter with AppleWorks. Along the way
you learned how to:

1. Create a masthead that contains text and a
graphic.

2. Create a footer that automatically numbers
your pages.

3. Use keystrokes to add a rule to a footer.

4. Use -[, -] and -\ to left-, right- and
center-justify text respectively.

5. Type a Return in a footer to set the footer off
from the text in the document.

6. Use dashes to add horizontal lines to footers.

7. Create multi-column linked text frames.

8. Add text-wrapped graphics to the documents.

9. Continue articles on following pages.

10. Create attention-getting colored boxes behind
your text.

Figure 16: After Shortening the Columns
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8. Press the Left-Arrow Key to de-select the text
and return the insert cursor to the left of the
“W”.

9. Select “Paragraph” from the Format Menu
and change the “Space Before” to 8 points.
Your screen should look like Figure 18. Save
your work.

Continuation of the Main Article

Finally, you will add the continuation of the arti-
cle that carried over from page one. Follow these
steps to add the title frame and text:

1. Select the Arrow Tool. Then scroll up to page
one and click once in the text of the article
on that page. AppleWorks will display the text
frame.

2. Click on the down-pointing triangle at the
bottom of the frame. Then scroll down to
page two without clicking anywhere else in
the document.

3. Using the rulers as a guide, put the cursor 31⁄2-
inches in from the left margin and aligned
with the top of the blue box to its left. Then
click and drag to create a text frame that
extends to the right margin and to the top of
the footer at the bottom of the page. The con-
tinuation of the article will automatically flow
into your new frame.

4. Click in front of the first word of the text.
Press the Return Key to make room for the
headline.

5. Press the Up-Arrow Key to put the insert cur-
sor at the beginning of the frame. Then select
Stone Sans ITCTT, bold, 18 point as the font
for the headline.

6. Type Democracy. Press the Space Bar but do
not press the Return Key.

7. Change the font to Times, italic, 10 point and
type (Continued from page 1.).

8. Select the Line Tool. Hold down the Shift Key
and draw a horizontal rule under the headline.

9. Click twiceanywhere in the attribution line at
the end of the article. Press -] to right justify

Special Sample Issue Page 13
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that text. Then triple-click on the text and
change the font style to italic. Your screen
should look like Figure 19.

10.Once again, check if the footer fits on one
line. If it runs onto two lines, click anywhere
on the rule and press the Delete Key. Then

Figure 18: Completed School News Article

Figure 17: After Drawing the Rectangle
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double-click on the Arrow Tool to de-select any
selected objects. Save your work.

Conclusion

There you have it – your first newsletter created
with AppleWorks. Now you can use your sample
newsletter as the basis for your own newsletters –
just replace the text and graphics in your saved
two-page newsletter and you have a customized
format to create your own publication. ■

Figure 19: After Completing Continued Article

Keyboard Reminders

AWUG uses Macintosh keyboard conventions in the
AppleWorks Journal. Windows users should substitute the
following keystrokes when completing the tutorials in
each issue:

Mac Windows

Press the Control Key (or Ctrl Key). For exam-
ple, press Control-S when an author says 
“Press   -S”.

Option Press and hold down the Alt Key when an
author tells you to use the Option Key.

Return Press the Return, Enter, ←, or ↵ key on the key-
board when asked to “Press the Return Key”.
(Windows keyboards label this key differently.)
Do not press the Enter Key on the numeric key-
pad unless specifically instructed to do so.

Windo ws

Here are some of the services available to
AWUG members:

MUG Store: The Macintosh User Group (MUG)
Store offers user group members discount prices on
refurbished and used Macintosh systems and
peripherals. Access to the MUG Store requires a
user ID and password. AWUG publishes this infor-
mation quarterly in the AppleWorks Journal.

MacConnection/PC Connection: AWUG mem-
bers receive free overnight shipping and special dis-
count prices from this nationally known mail order
dealer. To qualify, you must order from Dan Marrs
at (800) 800-0014 ext. 71384 and provide your
AWUG member number.

Educators: AWUG members who are educators
should check Apple’s educator prices before buying
any Apple-brand equipment or software. To access
Apple’s educators’ prices go to <www.apple.com/
education> and click on “The Apple Store”. Educa-
tors buying in quantity for their school or classroom
should contact Apple’s Education Volume Licens-
ing office at (800) 747-7483. Please tell them that
you learned about their services from AWUG.

International Members: Some hardware and soft-
ware vendors do not ship outside the United States.
As a service to members, AWUG will buy software
and small hardware items for members and re-ship
those items to your address abroad. However, (1)
AWUG cannot be responsible for final delivery to
you, (2) You must pay the cost of shipping the item
to AWUG plus the cost of reshipping the item to
you via international airmail, and (3) AWUG must
charge a $25 per order fee to cover our credit card
fees and other costs. For help with international
orders, please write to <orders@awug.org> ■

Member Benefits
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AWUG News

The AppleWorks Users Group (AWUG) is an association dedi-
cated to supporting AppleWorks users. AWUG provides techni-
cal assistance and information about AppleWorks and enhance-
ments to that program. Our primary means of communicating
with members is through the organization‘s publication entitled
the AppleWorks Journal.

http://www.apple.com/education
http://www.apple.com/education


Consider these five questions:

• How old are your students?

• How many days overdue are your
customers’ accounts?

• Which patients need their dental
checkups this month?

• Which buses need their monthly
oil change tonight?

• How many days until you must pay
your estimated taxes?

These questions all ask “How much
time has elapsed since an event?” or
“How long is it before a future event?”

Until now you probably did these calculations
manually; the subtraction process is easy – as long
as the two dates are in the same month. But this
article will show you how to use AppleWorks to
quickly calculate the number of years, months and
days between anytwo dates in database records.
[Ed: Copies of the databases described in this arti-
cle are on AWUG’s Journal Templates.11 disk that
you can download from AWUG’s website at
<www.awug.org> or order on AWUG’s June/July
2002 CD for $14.95 (plus $2 U.S. s/h).]

We will assume you know how to create an Apple-
Works database and how to define database fields.

Calculating Number of Days

Let’s start by calculating the number of days between
two dates. As you will see, the process is easy – just
follow these steps:

1. Create a new database with two date fields
called “Date.1” and “Date.2”.

2. Define a calculation field called “Days between”.
Enter the formula ABS('Date.2'-'Date.1') and con-
firm that “Format result as” is set to “Number”
(see Figure 1).

This formula says “Calculate the number of days
between Date.1 and Date.2 and display the
absolute value of that number.” (The “absolute
value” of a number is the positive value of that
number. For example, the absolute value of “-3” is
“3”. Adding the ABSolute function to the formula
eliminates the negative result that will appear if
you put the earlier date in the Date.2 field.)

3. Click on “OK” and then on “Done”.

Now you will enter data into the file. Continue as
follows:

4. Type 1/1/1947 in the Date.1 field and 1/1/2003
in the Date.2 field. Press the Tab Key. Apple-

Calculating Elapsed Dates in Database Records
by Bill Thomas, Warren Williams and Ron Fairchild

Bill Thomas, a former pilot in the U.S. Air Force, is a
retired elementary school teacher who used Apple-
Works to maintain student records and for other
administrative tasks.

Dr. Warren Williams, the President of AWUG and
Editor of the AppleWorks Journal, is a Professor
Emeritus at Eastern Michigan University in Ypsilanti,
Michigan.

Ron Fairchild, the Director of Software Development
for Kaiser Optical Systems, is the Technical Editor of
the AppleWorks Journal.

Figure 1: Defining Days between Date Fields
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Works will immediately display the number of
days between those dates (see Figure 2). (Don’t
be concerned if AppleWorks displays these dates
with a two-digit year (such as “47” or “03”). As
long as you enter a four digit year, AppleWorks
will “remember” the date and will perform the
correct calculations.)

5. Add a second record to the database and enter
4/15/2002 and 4/1/2002 into the Date.1 and
Date.2 fields respectively. Press the Tab Key and
AppleWorks will display the number of days
between those dates.

As you can see, calculating the number of days
between two dates is easy. We suggest that you
write down the formula in step #2 – it’s a universal
formula to find the number of days between two
dates. Then close this database without saving your
work.

Calculating Elapsed Days, Months and Years

Now that you know the basics, let’s try a more
complex calculation: In this case, determining the
number of years, months and days that elapsed
between an earlier event and today.

In this exercise, let’s have AppleWorks calculate
the age of every person in a database. That is, we’ll
ask AppleWorks to calculate the number of days,
months and years since each person was born.
Once you know how to perform this calculation,

you can use these techniques to calculate
(a) the elapsed time since any event, or
(b) the time remaining until a future
event.

Follow these steps:

1. Create an AppleWorks database with
three fields:

Field Name Type

First Name Text
Last Name Text
Birthdate Date

Now you will add a calculation field that
puts today’s date in every record. Continue
as follows:

2. Create a fourth database field called “Today”.
Specify that this is a calculation field and enter
the formula NOW(). Set “Format result as” to
“Date” (see Figure 3). Then click on “Done”.

Next, you will define fields that calculate the num-
ber of years, months and days since you were born.1

Continue as follows:

3. Create a new calculation field called “Elapsed
Years” and enter the formula 
INT(('Today'-'Birthdate')/365.25)

This formula tells AppleWorks to subtract the
numeric value of your birthdate from today and
then divide the results by 365.25 (the “.25”
allows for leap years). The Integer function
(INT()) tells AppleWorks to drop any decimal
places and just report the whole number value.

Confirm that “Format results as” is set to “Num-
ber” – you want to see the number of years since
your birthdate. Then click on “OK”.

____________________________________

1 The formulas in this manuscript are correct. If you get an error
message, have someone read the formulas to you as you proof-
read them on your monitor. Any error will cause them to fail.
The formula in step #5 below is too long to display in the For-
mula window. After you enter the formulas, you can use the
Arrow Keys to scroll around the contents of the window.
We included English-language “translations” of these formulas
for technically-minded readers. Fortunately, you do not need to
understand the operation of these formulas to use them.

Figure 2: Calculating Days between Dates
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4. Create a calculation field called
“Elapsed Months” and enter the follow-
ing formula: MOD(MONTH('Today')-
MONTH('Birthdate') +12-IF(DAY('Today')
<DAY('Birthdate'),1,Ø),12)

This formula says: “Subtract the month
of your birthday from the current
month. This value may be less than
zero if you haven’t had your birthday
yet this year. Now add twelve to that
value, which will make it a positive
number between one and 23. Next,
subtract one from that value if the cur-
rent day of the month is less than the
day of the month you were born.
Finally, divide the resulting number by
twelve and save the remainder. (The
MOD function performs the division
and captures the remainder.) That
remainder is the number of months
since your birth beyond the elapsed
years you computed above.”

Confirm that “Format results as” is set
to “Number”. Then click on “OK”.

5. Create another calculation field called
“Elapsed Days” and enter the formula
DAY('Today')-DAY('Birthdate')+IF(DAY
('Today')>=DAY('Birthdate'),Ø,IF(DAY
('Today'-DAY('Today'))<DAY('Birthdate'),
DAY('Birthdate'),DAY('Today'-DAY('Today'))))

This formula says: “Subtract the day of the
month in which you were born from the current
day of the month. If the current day of the
month is greater than or equal to the day of the
month in which you were born, the calculated
value is the number of days since your birth
beyond the elapsed years and elapsed months
you computed earlier. If (a) the current day of
the month is less than the day of the month in
which you were born, and(b) the last day of
last month is less than the day of the month in
which you were born, then add the day of the
month in which you were born to the previ-
ously calculated value. Otherwise, add the last
day of last month to the previously saved value.

The resulting value is the additional days since
your birth beyond the elapsed years and elapsed
months you computed above.”

Confirm that “Format results as” is set to
“Number”. Then click on “OK” and “Done”.
Your screen should look like Figure 4.

6. Now you should enter some records in your
database. Start with your own information and
see if the results are correct. Then create addi-
tional records for members of your family.

Generalizing Your Database

Now that you know how to calculate everyone’s age,
let’s generalize this database to serve different pur-
poses. For example, to determine how long a bill pay-
ment is overdue, just change the Birthdate field in
the database to “Date Due” and change all references
in the formulas from 'Birthdate' to 'Date Due'. The

Figure 4: Completed Database without Records

Figure 3: After Defining the Today Field

1. Enter the formula.

2. Select “Date”.

3. Click on “OK”.
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calculated Elapsed Years, Months and Date fields will
then display the number of years, months and days
since the bill became due.

You can also modify the database and formulas to
calculate the elapsed number of years, days and
months between any two events. Follow these steps:

1. Rename the “Birthdate” field to “Date.1”; leave
the field type set to “Date”.

2. Rename the “Today” field to “Date.2” and
change the field type to “Date”.

3. Change all references in the formula from
“Birthdate” to “Date.1” and from “Today” to
“Date.2”. The three modified formulas are:

Elapsed Years:
INT(('Date.2'-'Date.1')/365.25)

Elapsed Months:
MOD(MONTH('Date.2')-MONTH('Date.1') +12-
IF(DAY('Date.2')<DAY('Date.1'),1,0),12)

Elapsed Days:
DAY('Date.2')-DAY('Date.1')+IF(DAY('Date.2')
>=DAY('Date.1'),0,IF(DAY('Date.2'DAY('Date.2'))
<DAY('Date.1'),DAY('Date.1'),DAY('Date.2'DAY
('Date.2'))))

These formulas will calculate the elapsed years,
months and days between any two dates you
enter into your records.

4. When you enter data into the database, you
must enter the earlier date in the Date.1 field
and the later date in the Date.2 field.

Conclusion

Although the formulas we described in this article
are complex, they make date calculations easy –
we suggest that you write them down somewhere
and keep them handy. But we admit to not creat-
ing these formulas from scratch – we found
generic equivalents of these formulas in a Tech-
Info article created by Claris Corporation for File-
Maker. We simply modified these formulas for
AppleWorks.

Of course, building on the work of others is one of
the joys of using AppleWorks. ■

How to Use AWUG’s 
AppleWorks Journal Index

AWUG is now in its twelfth year of support for
the AppleWorks community. To date, we
have published more than 3,000 pages of

articles filled with news, offers, tips, techniques
and ideas to help you use AppleWorks.

Your back issues of the AppleWorks Journaland
the AppleWorks Journal CD Compendium contain
a valuable collection of materials for your home,
business or school. However, finding the articles
you need becomes more difficult as your library
grows. That is why we produce the AppleWorks
Journal Index, an AppleWorks database that lists
all the articles published in the AppleWorks Jour-
nal.

AWUG members can download the AppleWorks
Journal Index from AWUG’s website at <www.
awug.org>. Follow these steps to download the
index:

1. Navigate to <http://www.awug.org>.

2. Click on “AWUG Public Domain Software”.

3. Click on “Member” and enter your AWUG
member number.

4. Search for the disk named “Index.01”. Down-
load that disk.

We suggest that you download the AppleWorks
Journal Index every month or two to keep current.

AWUG also maintains an interactive version of
the index that is available on AWUG’s website. To
use that index, go to AWUG’s website at <www.
awug.org> and click on “AppleWorks Journal
Index”. Then use the search engine available on
that page to locate the articles you need.

The latest version of the AppleWorks Journal Index
is also on each month’s AWUG CD, which costs
$14.95 (plus $2 U.S. s/h) directly from AWUG. ■
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One of the joys of using AppleWorks is discov-
ering the entertaining and educational
activities you can do with the program. And

so it is with AppleWorks coloring books. As you
will learn in the following tutorial, selecting and
finishing free coloring book pictures that you find
on the Web is easy and fun. It helps children (and
adults) learn how to use AppleWorks’ painting
tools, and (if you pick the right coloring book) it
can have great educational value.

But you’ll see all this as you learn how to create the
coloring “masterpiece” in Figure 1. [Ed: A com-
pleted copy of the AppleWorks document in Figure
1 is on AWUG’s Journal Templates.11 disk that
members can download from AWUG’s website at
<www.awug.org>. The Journal Templates.11 disk
is also on AWUG’s June/July 2002 CD, which costs
$14.95 (plus $2 U.S. s/h) directly from AWUG.]

Finding Coloring Books

With all the resources available on the Web, it’s
not surprising that you can find hundreds of color-
ing books available for free downloading from dif-
ferent websites. You will start by using Google, a
popular search engine, to find a coloring book for
your exercise. Follow these steps:

1. If necessary, connect to the Web and launch
your browser. (America Online users: America
Online’s browser does not capture graphics in a
file format you can read reliably with Apple-
Works. If you use America Online, sign onto
AOL, launch Netscape or Internet Explorer,

and use either of those browsers to access the
Web.)

2. Go to <http://www.google.com>. (On most
browsers, you only need to type “google” (with-
out the quotation marks).) Despite its unusual
name, Google is one of the Web’s most popular
and powerful search engines.

3. Type “coloring books” into Google and click on
“Google Search”. Google will display the first of
ten pages of coloring books and related
resources available on the Web. Explore these
links and you will discover coloring books in
dozens of interesting areas.

4. Look down the list and click on “US Coast
Guard - Coloring Books”.

Genny Ota teaches grades K-4 at Wildwood Elementary
School in Mountain Lakes, New Jersey, where she uses
AppleWorks templates extensively to create projects.
Genny reports that along the way, her work becomes fun.

Cathleen Merritt, Director of AWUG and Associate
Editor of the AppleWorks Journal, has published more
than 300 articles in computer and technology maga-
zines and newsletters.

Figure 1: Completed Coloring Book Page
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5. Click on “Our Day with the Coast Guard” and
then on “Page 3”. Your browser screen should
look like Figure 2.

Capturing the Page

Now you will save the page from this coloring book
in a file you will insert into AppleWorks. [Ed: A
copy of this file is also on AWUG’s Journal Tem-
plates.11 disk.] Continue as follows:

6. Hold down the Control Key. Then press and hold
the mouse button anywhere on the page to display
a contextual menu. (Windows users: Right-click
on the page.) Select the option that lets you save
the image on your hard drive. (For example, using
Internet Explorer 5.0, choose “Download Image
to Disk” (see Figure 3).) Accept the default name
“ourday3.gif” and save the file on your desktop.

7. Close the browser window or quit the browser;
you will not need it for the rest of this exercise.

Importing into AppleWorks

Now you will import the graphic into AppleWorks.
Continue as follows:

8. Launch AppleWorks and create a new painting
document.

9. Choose “Resolution and Depth” from the For-
mat Menu and confirm that the resolution is set
to 72 dpi and the depth to 256 colors. Although
these settings do not provide a high resolution
image, they conserve memory and are adequate
for a coloring book.

10.A.Macintosh users: Select “Insert” from the File
Menu. 

If you use AppleWorks 6, select “All avail-
able” from the pull-down File Format Menu
in the Insert dialog.

Navigate to the “ourday3.gif” file that is on
your desktop. Click on the file name and
then click on “Insert”. Your screen should
look like Figure 4. If you have a problem, see
the sidebar “If Things Go Wrong” for ideas
that can help you insert the coloring book
graphic into your AppleWorks document.

Figure 2: Page You will Save

Figure 3: Saving the Image

Figure 4: After Inserting the Graphic
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B. Windows users: Re-size the painting docu-
ment so you can see the ourday3.gif file on
your desktop. Click on the file and drag it
into your AppleWorks painting document.
Then skip to step #13.

11.The coloring book page does not fit in the Apple-
Works document, so you will shrink the graphic.

Select “Scale By Percent” from the Transform
Menu and type “75” in each of the two dimen-
sions. Then click on “OK”.

12.Click and hold on the graphic and drag the
image so it is centered on the page. (If you can-
not see the entire page, switch to 75% view for
the rest of this tutorial.) Then release the
mouse button. Your screen should look like
Figure 5.

13.Save your work on the desktop in a file called
“Coast Guard”.

Start Coloring

Now it’s time to start coloring your picture. You
will encounter some problems along the way, but
learning how to solve these problems is one of the
reasons you’re doing this tutorial.

Continue as follows:

14.Select the Paint Bucket Tool and choose a fill
color of a bright blue (see Figure 6). Then click
on each of the doors in the building to color
them blue. (The “action point” of the Paint
Bucket is at the end of the paint that is flowing
out of the bucket. Put that point in the area you
want to fill.) If something goes wrong, immedi-
ately choose “Undo Paint” from the Edit Menu.

15.With the Paint Bucket still selected, change the
fill color to any shade of green.

16.Click on the bush to the left of the doors. Then
click on the bush to the right of the doors.
With some versions of AppleWorks, everything
turns green – don’t panic (and don’t click any-
where). We’ll fix that in a moment.

Is Everything Green?

Some systems turn the document green because
the right bush is not a “closed” figure with some

Figure 5: After Positioning the Graphic

Figure 6: Selecting the Fill Color – AppleWorks 6

Fill Formatting Button.

Pen Formatting Button.
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versions of AppleWorks. As you just discovered, if
the shape isn’t closed, the Paint Bucket Tool con-
tinues to fill other objects seeking “closure”. If
there are missing pixels in the outline of the bush,
the Paint Bucket fills almost everything on the
page because there are no boundaries to keep it
contained. You can visualize the color “leaking”
out from breaks in the outline of the bush.

Other versions of AppleWorks import the graphic

with a “closed” bush. On these computers, the
color does not “leak” out of the bush.

No matter what happened on your screen, follow
these steps to learn how to create closed figures.
You will use these procedures when you fill in
other coloring books you download from the Web.

Continue as follows:

17.Select “Undo Paint” from the Edit Menu to
restore your document.

18.Switch to 200% view. (To do that, click on the
large “mountain” at the bottom-left corner of
the document window.)

Examine the bush to the right of the door (see Fig-
ure 7). Note the light gray and missing pixels in
the lower-right corner of the bush – that’s where
the fill color “leaked” out to the rest of the picture.
Let’s fix that. Continue as follows:

19.Select the Pencil Tool. Then…

Figure 7: Broken Outline of the Bush

Missing pixels.

Figure 8: After Completing the Bush

Figure 9B: The Pattern Palette – AW 6

Figure 9A: The Pattern Palette – AW 5 and Earlier

Opaque

Transparent

Opaque

Transparent
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A. AppleWorks 5 and earlier: Set the fill color
to black. Then set the pen width to two
points.

B. AppleWorks 6 users: Change the fill color to
black. Then click on the Pen Formatting
Button (see Figure 6) and change the pen
width to two points.

20.Use the Pencil Tool to draw a black line that
completes the bush (see Figure 8).

Now you will color the second bush. For instruc-
tional purposes, we will assume you don’t remem-
ber which shade of green you chose for the first
bush. Continue as follows:

21.Select the Eye Dropper Tool. Put the “dropper”
end (not the squeeze end) so it is over the green
in the first bush. Then click the mouse button.
That tells AppleWorks to “pick up” the color
from the bush. (Note that the Fill Button in the
Tool Palette changes to green).

22.Select the Paint Bucket Tool and click in the
second bush to color the bush green. Don’t
worry about any imperfections in the way the
color fills the bush – it just adds to the “crayon”
look of the final piece.

23.Use the Zoom Controls to return to 75% or
100% view.

Now you will color more objects. Continue as fol-
lows:

24.Select a brown fill color and click in the boy’s
hair. (AppleWorks 6 users: Click on the Fill For-
matting Button before you select brown from
the color palette.)

25.Select a bright blue fill color. Then choose a
dotted pattern from the Pattern Palette. Click
on the top and bottom of the boy’s shirt.

26.Once again, open the Pattern Palette. This
time, select the opaque option (see Figure 9).
Then click on the boy’s shorts to fill them with
blue.

Now you will put a red brick front and a dark gray
roof on the building. Continue as follows:

27.Select a “brick red” color from the fill color
palette.

If Things Go Wrong…
One of the fascinating aspects of the accompanying
article is the way it integrates different technologies.
Think of it: You capture a graphic from a Web page,
download the image onto your system as a gif file
and insert that file into an AppleWorks document.

When things go right, it’s exciting to see how every-
thing works together. But there are many opportuni-
ties for things to go awry during this process. 

You usually discover there’s a problem when you try
to import your saved graphic into AppleWorks.
Then the gif file doesn’t appear in the Insert dialog
or AppleWorks says it cannot insert the file.

Here are six suggestions to try when you have diffi-
culty inserting the “ourday3.gif” file into your
AppleWorks painting document:

1. Capture a new copy of the gif image from the
Coast Guard website. Try to insert that new file
into your AppleWorks document.

2. Download the ourday3.gif file on AWUG’s Jour-
nal Templates.11 disk. See if you can insert that
file into AppleWorks.

3. If you own MacLinkPlus Deluxe, launch it and
drag your copy of the ourday3.gif file onto the
MacLinkPlus window. Confirm that the file type
is “GIFf”. If MacLinkPlus’ Fix button becomes
active, click on it to fix the file. Then try to
insert the file into your AppleWorks document.

4. If you use OS 9.x or earlier, reboot your com-
puter and hold down the Option and Keys to
rebuild the desktop. Then re-launch Apple-
Works, create a new painting document and try
to insert the file.

5. Run Norton Disk Doctor, DiskWarrior, Drive 10,
or TechTool Pro to repair any damaged files on
your hard drive. Then re-launch AppleWorks,
create a new painting document and try to insert
the file.

6. AppleWorks 5 or earlier: Quit AppleWorks and
return to the Finder. Search for a file called
“XTND Translator List” and drag that file into
the trash. Then re-launch AppleWorks, create a
new painting document and try to insert the
graphic.

But we must admit that even with this long list of
possible remedies, there are still no guarantees that
you’ll successfully import the gif file into AppleWorks.
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28.Select the brick pattern from the bottom row of
the pattern palette.

29.Click anywhere in the front of the building. As
you can see, you clicked on another open shape.
Select “Undo Paint” from the Edit Menu.

Adding an Outer Boundary

Study the front of the building and you’ll notice
that the entire left edge of the building is open to
the rest of the picture. (Windows users: Apple-
Works for Windows draws a frame around the fig-
ure, so the side of the building is not “open”. You
should skip to step #33.) This looks good in a col-
oring book, but it leaves the shape open so you
cannot fill it with the Paint Bucket Tool.

Look around the edge of the entire picture and you
will see that all the objects at the edge lack an
outer boundary. Let’s add that boundary now so we
can fill these objects. Continue as follows:

30.Select the Rectangle Tool. Then…

A. AppleWorks 5 and earlier: Choose the trans-
parent icon from the Pattern Palette. (It’s
the upper-left icon in the palette; see Figure
9A.)

B. AppleWorks 6 users: Click on the Fill Format-
ting Button. Then choose the transparent
icon from the Pattern Palette. (It’s the upper-
left icon in the palette; see Figure 9B.) Then
click on the Pen Formatting Button and con-
firm that the line width is set to two points.

31.Your goal now is to draw a rectangle that runs
along the top of the figure and intersects the
end of the building on the left edge of the page
and the boat on the right.

Using Figure 10as a guide, click and drag to
draw the rectangle. If you make a mistake,
immediately select “Undo Paint” from the Edit
Menu and try again.

32.Now repeat steps #27-29 and once again try to
fill the front of the building with red bricks. As
you discovered, the fill still “leaks” out to the
rest of the picture. Select “Undo Paint” from
the Edit Menu.

Figure 11: Breaks in Roof Line

Note breaks.

Figure 10: After Drawing an Outer Boundary

You may have 
a break here.
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Now you will fix the breaks in the lines that define
the shape you are trying to fill. Continue as follows:

33.Switch to 200% view and look at the lines that
outline the front of the building (see Figure
11). You’ll find a break along the roof line and,
with some versions of AppleWorks, a second
break in the lower-left corner of the building.

34.Select the Line Tool and set the pen color to
black. (AppleWorks 6 users: Also set the fill
color to black and the fill pattern to opaque.)

35.With the Line Tool still selected, click where
the rooftop of the building meets the left mar-
gin. Then click and drag to scribe a solid line
along the roof of the building.

36.Repeat this process to re-draw the remaining
two lines that define the roof. If necessary, also
re-draw the line to the left of the bush.

37.With the Line Tool still selected, re-draw the
short line that defines the far end of the pier.
Your screen should look like Figure 12.

38.Return to 75% or 100% view. Then select the
Paint Bucket Tool and, once again, repeat steps

#27-29. Ah...success! Your screen should look
like Figure 13.

39.Select a medium gray fill color and the opaque
pattern. Then click on the roof to fill it with
gray.

40.Select a light gray and fill the pier with gray.

Conclusion

Now that you have the idea, you’re on your own to
color the rest of your graphic. Using the Paint
Bucket Tool, click in an object. If it “leaks”, undo
the fill and “repair” the source of the leak. Pretty
soon you’ll have the completed coloring book page
in Figure 1.

After a while you and your students will become
comfortable with these procedures, which means
you’ve learned how to use AppleWorks’ painting
tools – and that’s another objective you accom-
plished in this lesson. ■

Figure 13: After Filling the Building

Look here.

Figure 12: After Drawing New Lines

New lines.

New line if 
necessary.
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